## A table of contents

1. TextEditor .................................................................................................................. 1
2. Operating environment .................................................................................................. 1
3. Startup .......................................................................................................................... 1
3.1 Start of TextEditor ...................................................................................................... 1
4. Creation of a new model ................................................................................................. 2
4.1 Model creation ............................................................................................................. 2
4.1.1 Creation of a new model .......................................................................................... 2
4.1.2 EntryModel ........................................................................................................... 2
5. Registration of compartment .......................................................................................... 3
5.1 Registration of compartment ....................................................................................... 3
5.1.1 ReactionList .......................................................................................................... 4
5.2 Edition of compartment volume .................................................................................. 4
6. Explanation of specie list ................................................................................................. 5
6.1 Specie list ..................................................................................................................... 5
6.1.1 SpecieList spreadsheet ........................................................................................... 5
6.1.2 Compartment tab ................................................................................................... 5
6.1.3 AddSpecie button ................................................................................................... 5
6.1.4 ReactionList button ............................................................................................... 5
7. Registration and edition of species ................................................................................. 6
7.1 Registration of species ................................................................................................. 6
7.1.1 New registration of a species ................................................................................... 6
7.1.2 Screen for registering a specie ............................................................................... 7
7.2 Specie edition .............................................................................................................. 9
7.2.1 Edition of a specie ................................................................................................. 9
7.2.2 Species edition ..................................................................................................... 10
8. Explanation of screen for listing reactions ................................................................. 12
8.1 Switching the screen mode for listing reactions ........................................................... 12
8.1.1 All mode ............................................................................................................... 12
8.1.2 Convertible mode .................................................................................................. 12
8.2 Explanation of screen for listing reactions .................................................................. 12
8.2.1 ReactionList spreadsheet ..................................................................................... 12
8.2.2 Layer tab ............................................................................................................... 13
8.2.3 AddReaction button ............................................................................................ 13
8.2.4 SpecieList button ................................................................................................. 13
9. Registration and edition of reaction .............................................................................. 13
9.1 Registration of reaction ............................................................................................... 13
9.1.1 Registration of a new reaction .............................................................................. 13
9.1.2 Registration of reaction (All mode) ...................................................................... 14
9.1.3 Registration of reaction (Convertible mode) ............................................................ 16
9.2 Edition of reaction ..................................................................................................... 17
9.2.1 Edition of reaction ............................................................................................... 17
9.2.2 Edition of reaction (All mode) ............................................................................. 18
9.2.3 Edition of reaction (Convertible mode) ................................................................. 19
Notice:
There are two kinds of CADLIVE editors: the GUI editor and text editor. Users are recommended to draw a large-scale biochemical network by using the GUI editor and to elaborately edit the generated regulator-reaction equations by using the text editor. The text editor handles the XML file created by the GUI editor, but the GUI editor cannot read the XML file edited by the text editor.
1. TextEditor

This editor constructs a concrete biochemical network in the sanac format, which is the extension from SBML (Systems Biology Markup Language), by input of strings and by choosing items on the spreadsheet. This editor can read the sanac files that have been edited by the CADLIVE GUI editor, and writes the sanac files necessary for the simulator of CADLIVE.

2. Operating environment

Hardware:
CPU : Pentium3 500MHz or higher
Memory : >64MB (>256MB is recommended)
HDD : >1Gb

Software
Windows 98, NT4.0, 2000, XP
Java™ 2 Runtime Environment (1.3 is recommended)

3. Startup

3.1 Start of TextEditor

Java™ 2 Runtime Environment (1.3 is recommended) is required. Start by choosing the [TEXTEDITOR] menu from the program menu.
4. Creation of a new model

4.1 Model creation

4.1.1 Creation of a new model

Click [File] and select [New].

4.1.2 EntryModel

Input "ModelName". If necessary, input "ModelInfo".

Clicking the [OK] button displays the screen for editing a network.
The button of [Cancel] cancels the entry model.

* When the [OK] button is clicked without inputting ModelName, warning is given.
5. Registration of compartment

5.1 Registration of compartment

In the screen for the specie list, clicking the [Add Compartment] tab opens the screen for registering the compartment. The tab of [Add Compartment] sets "Compartment", the tab of [Edit Compartment] edits the existing information regarding the compartment. Users select the compartment name from the selectbox or input it manually. If necessary, input "Volume".

Following the input, clicking the [Add] button registers "Compartment". Clicking the [Clear] button resets input data.
* The added compartment is deleted from the selectbox.

When "Compartment" is missed, clicking the [Add] button displays the error as follows.
5.1.1 ReactionList
To make new reactions or to refer to the list of reactions, click the [ReactionList] button; the screen for the reaction list appears.

5.2 Edition of compartment volume

Select "Compartment", whose volume users want to change, from the selectbox, and input "Volume". Clicking the [Update] button updates the volume of the selected compartment.

* The selectbox shows the registered compartments.
6. Explanation of specie list

6.1 Specie list

6.1.1 SpecieList spreadsheet
The registered species are listed every compartment. Double clicking the specie on the spreadsheet displays the window for editing a specie.

6.1.2 Compartment tab
The compartment tab shows the compartment that the specie belongs. Clicking the tab displays the list of the species located in the compartment. The tab of "AddCompartment" registers a new compartment.

6.1.3 AddSpecie button
This button registers a new species. Open the compartment tab, and click the [AddSpecie] button. The screen for registering species will be displayed.

6.1.4 ReactionList button
To make new reactions, or to refer to the list of reactions, click the [ReactionList] button. The screen for listing reactions is displayed.
7. Registration and edition of species

7.1 Registration of species

7.1.1 New registration of a species

Open the "Compartment" tab of interest, and click the [AddSpecie] button. The screen for registering a species is displayed.
7.1.2 Screen for registering a specie

- **SpecieID**
The system gives "SpecieID" automatically. (Users are not allowed to edit it)

- **SpecieName**
Name the specie arbitrarily.

- **Compartment**
Choose the compartment from the selectbox

- **Class**
Choose the class from the selectbox. Selection of the class sets the attribute of "TotalAmount", "MassBalance", and "Decomposition" as default values as follows.

- **Default value**

<table>
<thead>
<tr>
<th>SpecieClass</th>
<th>TotalAmount</th>
<th>MassBalance</th>
<th>Decomposition</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA_gene</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>DNA_promoter</td>
<td>constant</td>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>DNA_enhancer</td>
<td>constant</td>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>DNA_others</td>
<td>constant</td>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>Attribute</td>
<td>Value</td>
<td>Is Variable</td>
<td>Is On</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>RNA</td>
<td>variable</td>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>protein</td>
<td>variable</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>metabolite</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>environmental_factor</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>ion_signal</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>complex</td>
<td>variable</td>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>modified</td>
<td>variable</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>others</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>small_molecule</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>text_option</td>
<td>constant</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

- **TotalAmount**
  Choose the attribute of "TotalAmount" with the radiobutton.

- **MassBalance**
  Choose the attribute of "MassBalance" with the radiobutton.

- **Decomposition**
  Choose the attribute of "Decomposition" with the radiobutton.

- **InitialAmount**
  If necessary, set a numerical value to "InitialAmount".

- **ListofElements**
  The elements are selected from the selectbox.
  * The selectbox has the registered species.
  * Users can delete the input data by choosing [Delete] in the selectbox.

After setting, click the [Add] button to display the confirmation screen. If there is no problem, click [Yes] to register the specie.

Click the [Cancel] button to abandon the registration.

* When the item for input is shortage or required to reedit, the following warning appears.
  Click the [OK] button, and set the items again.
7.2 Species edition

7.2.1 Edition of a species

In the screen for listing the species, double clicking the species that users want to edit displays the window for editing a species.
7.2.2 Species edition

The edition is carried out in the same manner as the registration of a new species. After setting is completed, clicking the [Update] button displays the confirmation window. If there is no problem, click [YES] to update the data.

Click the [Cancel] button to abandon the registration.

* When the item for input is shortage or required to reedit, the following warning appears. Click the [OK] button, and set the items again.
* When the attribute of "Class" of the species is "ModifierComplex", the attributes of "SpecieName", "Compartment", "Class", and "ListOfElements" are not allowed to edit.
8. Explanation of screen for listing reactions

8.1 Switching the screen mode for listing reactions

8.1.1 All mode
All the reactions are listed despite the value of "isConvertible".

8.1.2 Convertible mode
The reactions with the attribute "isConvertible = true" are listed.
* For multiple reactions with the same "GroupID", they are not listed on the spreadsheet, when they contain a reaction with attribute "isConvertible = false".

8.2 Explanation of screen for listing reactions

8.2.1 ReactionList spreadsheet
The registered reactions are listed every layer. Double clicking the reaction on the spreadsheet displays the window for editing reactions.
8.2.2 Layer tab
The "Layer" tab indicates the layer that reactions belong to. Clicking the layer tab displays the list of reactions every layer.

8.2.3 AddReaction button
The [AddReaction] button is clicked to create a new reaction. Open the "Layer" tab, and display the screen for registering a reaction.

* When "All" mode has been selected, reactions are added separately. On the other hand, when "Convertible" mode has been selected, the reactions with the same "GroupID" are edited at the same time.

8.2.4 SpecieList button
Click the [SpecieList] button to edit a new species or to refer to the list of species. The screen for listing species appears.

9. Registration and edition of reaction

9.1 Registration of reaction

9.1.1 Registration of a new reaction
Click the “Layer” tab and click the [AddReaction] button, the screen for registering reactions is displayed.
* When "All" mode has been selected, reactions are added separately. On the other hand, when "Convertible" mode has been selected, the reactions with the same "GroupID" are edited at the same time.

9.1.2 Registration of reaction (All mode)

- **ReactionID**
  The system gives the “reactionID” to the reaction automatically. (Users are not allowed to edit.)

- **Layer**
  The “Layer” shows the layer that has been selected on the screen for listing reactions.

- **reactionType**
  Choose “reactionType” from the selectbox.
  When “reactionType” is selected, the examples are illustrated in the white box on the right as follows.

  - $\text{cf: gene}(A) \rightarrow \text{mRNA}(A)$
  - $\text{Promoter}(A), \text{Repressor} || \text{gene}(A) \rightarrow \text{mRNA}(A)$
  - $\text{Enhancer}(A), \text{Activator} -> \text{gene}(A) \rightarrow \text{mRNA}(A)$

- **isConvertible**
  This attribute determines if the reaction is converted or not to a mathematical model by the CADLIVE Simulator.
false: not converted
ture: converted.

- ListOfModifier
In order to register a regulator (modifier), the species is selected as “Modifier” from the selectbox.

- modifierType
The attribbute of “modifierType” is selected from the selectbox.

- isTotal
The attribute of “isTotal” is selected from the selectbox.

- ListOfReactants
The species are selected as reactants from the selectbox.
  * The selectbox registers the species, but it registers the reaction when “ReactionType “ is “activation_of_modifier”, or “inhibition_of_modifier”.
  * Users can delete the input data by choosing [Delete] in the selectbox.

- ModifierComplex
When “modifierType = enzyme”, choosing the element of “ListOfModifier” and “ListOfReactants” automatically produces the element of “ModifierComplex”.

- ListOfProducts
The species are selected as products from the selectbox.
  * The selectbox has the registered species.
  * Users can delete the input data by choosing [Delete] in the selectbox.

- ReactionEquation
The ReactionEquation is automatically generated. It is ModifierReactionEquation.

- Stoichiometry
If necessary, click the cell to input a numerical number.
Pushing the [Enter] key decides the stoichiometry.

After the setting, click the [Add] button to show the confirmation screen. Clicking [YES] to add the reaction.

To abandon the registration, click the [Cancel] button.
*When the item for input is shortage or required to reedit, the following warning appears. Click the [OK] button, and set the items again.

9.1.3 Registration of reaction (Convertible mode)

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”.

In the “Convertible” mode, multiple regulators (modifiers) are selected with respect to a specific reaction (“ListOfReactants” and “ListOfProducts”). These regulator-reaction equations are given the common “GroupID”. 
9.2 Edition of reaction

9.2.1 Edition of reaction

On the screen for listing reactions, double clicking the reaction displays the window for editing a reaction.

* When "All" mode has been selected from "View", reactions are added separately. On the other hand, when "Convertible" mode has been selected, the reactions with the same "GroupID" are edited at the same time.
9.2.2 Edition of reaction (All mode)

The edition is carried out in the same manner as the registration of the reactions. After setting, click the [Update] button to show the confirmation screen. Click [YES] to update the revision. To reedit, click [NO].

Click the [Cancel] button to abandon the registration.
Click the [Delete] button to delete the reaction.
* When the item for input is shortage or required to reedit, the following warning appears. Click the [OK] button, and set the items again.
9.2.3 Edition of reaction (Convertible mode)

The reactions with the same “GroupID” are edited together. When the “Convertible” mode has been selected, multiple regulators (modifiers) can be selected. In the other respects, “Convertible” mode is the same as “All” mode.

*The reactions with “IsConvertible = false” are omitted from the list on the “Convertible” mode, but the “All” mode displays all the reactions despite the value of “IsConvertible”.

The reactions with the same “GroupID” are edited together. When the “Convertible” mode has been selected, multiple regulators (modifiers) can be selected. In the other respects, “Convertible” mode is the same as “All” mode.

*The reactions with “IsConvertible = false” are omitted from the list on the “Convertible” mode, but the “All” mode displays all the reactions despite the value of “IsConvertible”.

- 19 -
10. Merge Function

10.1 Merge

In order to merge the existing network into the current network, choose [Merge] from the "File" menu and select the sanac file to be merged.

* The model name, comments, and data regarding visualization of a network to be merged are omitted, and integrated into the current model.

11. Explanation of menu items

11.1 File menu
11.1.1 New
A new model is created.

11.1.2 Open
An existing sanac file is opened.

11.1.3 Merge
An existing file is merged into the current file.

11.1.4 Save
The current network overwrites the existing one, and is saved.
* When saving a file without “ModelName”, the window for setting “ModelName” appears. Input “ModelName”, if necessary, “ModelInfo”.

11.1.5 SaveAs
The current file is named and saved.
11.1.6 Exit
Finishing the editor.

11.2 VIEW menu
Switching the view mode.

11.3 HELP menu
11.3.1 AboutTextEditor
The version of the TextEditor is displayed.